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Learning objectives | Multisite offsite preparation

At the end of this lesson, you should be able to:

• Describe the steps required for the off-site 
commissioning process.

• Be familiarized with the tools needed for 
online commissioning.

Offsite preparation 

Prepare dashboard in the cloud

Prepare System Builder job file

Plan installation

Plan commissioning

Multisite

Configure Smart Meter groups

Configure Modbus metering

Optional features configuration

Emergency Lighting 
configurations 

Customer input for Emergency 
Test schedule

1. Chrome web browser

2. Philips Dynalite Enabler app

3. System Builder >4.43 with technician license

4. Connectivity Toolbox software

Prerequisites:
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Multisite offsite preparation | Naming convention alignment

It is extremely important to keep consistent naming convention, during entire preparation process.

The naming convention covers the Areas, Child Areas, Scenes and Logical Channels.

The convention is first aligned with the customer by means of the Project Template form, and defined per customer, not per store or format.

Then, the naming is being used during preparation of the Dashboard in the cloud, and later-on mirrored to the System Builder configuration.

 

 
Project Template form       Dashboard – Cloud configuration                           System Builder

Multisite



Prepare dashboard 
in the cloud

Architecture FLX - Multisite
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Interact Cloud | Prepare dashboard in the cloud

Multiple web browsers support the usage of the IAR Retail dashboard. 

Google Chrome, Microsoft Edge, Mozilla Firefox, Apple Safari.

1. In the browser settings, change the cookies setting to Allow all cookies

2. Browse to the web page with the address: www.eu.retail.interact-lighting.com

3. Login and follow the authentication steps.

 

1

3

Multisite

http://www.eu.retail.interact-lighting.com/
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Interact Cloud | Add parent areas

1. In the top menu, click Configuration

2. On the left pane, select Area & Scenes

3. Select Format (for a specific format) or None (for all customer formats)

4. Click Create new area 

5. Enter the Parent Area name and ID (align with Project Template form), and press Save

6. Repeat for all Parent Areas

Optionally enable Day & Night Mode

Parent Area ID alignment is suggested to be consecutive (Area IDs 2, 3, 4….), starting from ID 2
Projects with many Child Areas can use Parent Areas 2, 4, and 6 to allow up to 20 Child Areas each

 
51

2

3

4

Multisite
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Interact Cloud | Add scenes

1. Hover over the action menu icon 

2. Click Create new scene

3. Enter the Scene name and ID (align with Project Template form), and press Save

4. Repeat for all Scenes within each Parent Area 

Scenes ID alignment is suggested to be consecutive (Scene IDs 1, 2, 3….) 

1

2

3

Multisite
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Interact Cloud | Add child areas

1. Click on the Parent Area, to show the list of child areas

2. Click Create new child area

3. Enter the Child Area name and ID (align with Project Template form), and press Save

4. Repeat for all Child Areas

It is suggested to assign Child Area ID, taking the ID of the Parent Area as a base. 

For example: Parent Area ID = 2, Child Area ID's 21, 22, 23….

1

2

3

Multisite
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Interact Cloud | Add logical channels

1. Hover over the action menu icon

2. Click Create new logical channel

3. Select the type of the Logical Channel

4. Enter the Logical Channel name and ID (align with Project Template form), and press Save

5. Repeat for all Logical Channels within each Child Area

Channels ID alignment is suggested to be consecutive (Channel IDs 1, 2, 3….)

For all Areas, make sure Channel 1 is always used.

1

2

3

4

Multisite

Correct energy data reporting requires
ON/OFF and dimmable outputs to be in 

different Logical Channels.
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Interact Cloud | Edit usage of areas, scenes and channels

In the Parent Area, or the Child Area view:

1. Click Edit usage

2. Use the check box to enable / disable Areas (Parent Areas or Child Areas)

3. Select the Scenes or Logical Channels to enable / disable them. Dark theme means that scene or channel is enabled

4. Click Save

1

2 3

4

Multisite
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Interact Cloud | Create concept

For a new format and cloud configuration, there is a need to create default concept.

Concept is a set of different lighting scenes and channel levels, designed for each Parent Area.

1. In the top menu, click Light control

2. On the left pane, select Concepts

3. Click +New concept

4. Give the concept a name and click Create

1

2

3

4

Multisite
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Interact Cloud | Edit concept 1/3

It is only possible to edit concept, with the status Draft. It is not possible to edit Deployed concepts

To modify settings of the deployed concept, create a Clone of the Deployed concept first, and then start editing.

1. Click on the name of a created concept

2. Click on the row of the Parent Area to start editing concept for that area

1

2

Multisite
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Interact Cloud | Edit concept 2/3

Start editing the light settings for the area:

1. Select a Scene to edit channel level settings

2. Switch the zone ON or OFF, using a toggle switch

3. Move the dim slider to adjust light level, or enter 
the value in the box

4. Use the Master slider to change the relative dim 
level of all zones that are switched to ON

5. Click Save changes

6. Repeat for the other scenes in the area

7. Repeat for the other Parent Areas in the concept 

1

2

3

4

5

Multisite

If you want to use the same levels on 
different Scenes just Copy dim levels 
and choose the Scenes you want to 
apply those in. Afterwards, you can 

fine tune those copied levels if 
needed.
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Interact Cloud | Edit concept 3/3

When one of the Parent Areas has the Day & Night Mode enabled, a specific 
configuration for scenes applies.

1. Select a Scene to edit channel light settings

2. Click on the Sun & Moon    icon, to activate the day-night setting.          
Two sliders show up, one for day, another for night.

3. Switch channels ON or OFF

4. Move the dim sliders to adjust light levels, for day and night.

5. Click Save changes

6. Repeat for the other scenes in the area, if the Day & Night Mode applies

Day and Night are determined by the Astro-clock functionality on the gateway

After sunrise, the Day setting is applied and after sunset, the Night setting.

1

2

34

5

Multisite
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Interact Cloud | Add schedule 1/3

Each format requires a default schedule. 

1. In the Light control tab, on the left pane, select Schedules

2. Click +Add Multisite schedule

3. Give the schedule a name and click Save

1

2

3

Multisite
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Interact Cloud | Add schedule 2/3

1. Click +Add to start creating the schedule

2. Select the Type of event (Simple event, Holiday, Special event)

3. Click the calendar     to select the Start date

4. Click the calendar     to specify the End date 

5. Clear/select the days for the Weekly Pattern

6. Clear/select the months for the Monthly Pattern

7. Click Next

8. Select to which Areas the schedule applies, then click Next

1

2

3 4

5 6

7

8

Multisite
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Interact Cloud | Add schedule 3/3

1. Enter the Name for the schedule (e.g., Standard Day)

2. Keep start time at 0:00 and click on the Unknown scene

3. Select the Scene and desired Fade time

4. Click the clock    to define the Start time and press Add Action

5. Select the Scene and Fade time

6. Repeat for other desired timeframes, then click Next

7. Verify created schedule, and click Add

1

2

3

4

5

6

7

Multisite
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Interact Cloud | Add Smart meter groups

This step is only required when smart meters are used in the project to measure energy consuption.

To configure Smart meter groups in the Multiste dashboard: 

1. Go to the Configuration tab.

2. On the left menu, select Smart meter groups.

3. Click Create metered group to create one.

4. Enter a Group name for the metered group and provide a Group description.

5. Click the dropdown and select Select All. Click Save.

6. Add all required Smart meter groups (power zones) by repeating the steps above.

Multisite

3
2

1

4

5
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Multisite offsite preparation | System Builder job file Template

Commissioning with System Builder job file template:

- Speeds up commissioning 

- Minimizes errors

- Requires fine tuning to match the Project Template PDF form 

and the Cloud configuration.

Download the SB job file template from the Partner Portal that 

matches your PDDEG-S hardware version (new projects will 

have PDDEG-S v3 which has 2 RJ45 ports):

Software and Tools> FLX> multisite> Multisite Master Template

*You can edit the SB job file template to match your Customer 

requirements and apply it in multiple sites. Avoid reusing site 

projects that are already stored in the cloud as they attach 

certificates that can't be reused in other projects.

 

Multisite

https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
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System Builder | Clean up Template

Offsite preparation

1. Open the Multisite Master Template SB job file.

2. In “Areas” view, delete Areas that are not supposed to be in use based on Project 

Template Form. 

• Ensure Areas have proper numbers according to the Project Template Form

• Check folder names and adjust if appropriate.

• Check Areas Properties tab, are the BLA's set properly ?

3. In “System” view, delete all PDDEG-S except 1:

- Those 2 which don't match the architecture among:

- PDDEG-S - project with Energy Meters Modbus IP Architecture: 

- PDDEG-S - project with Energy Meters RS485 Architecture

- PDDEG-S - project without Energy 

Multisite

2

1
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System Builder | Timezone

Offsite preparation

1- Set the Job file Location and Time Zone to match the project requirements. 

For that:

- Go to Tools from the top bar menu and select Set Location and Time Zone.

- Edit the settings if needed to match the project Location and Time Zone.

- Click OK even if no changes are made.

2- Set the PDDEG-S Location and Time Zone to match the project 

requirements. For that:

- Right click on the PDDEG-S and select Set Location and Time Zone.

- Edit the settings if needed to match the project Location and Time Zone.

Multisite

2

1
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System Builder | Design Mode 1/4

System Designer is a tool which streamlines the process for generating control system design. 

In order to use System Designer, a technician license for System Builder is required.

It's highly recommended to study the dedicated User Guide first:                           

in System Builder click Help → User Guides and select the System Designer User Guide. 

To start with project design:

1. Click Design icon       to start the System Designer Mode

2. Follow all the steps of the Design Assistant

2

1

Multisite
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System Builder | Design Mode 2/4

Multisite

Take special attention for the following attention points:

1. In step 5. Define Scale:

This step is essential to automatically calculate the Total Floor Area. There are two ways to 
define the Scale:

1. Draw Background Scale: search in the floorplan some reference with known length, 
such as a specific luminaire. Draw a segment on top of the chosen reference and enter the 
known length in meters on the pop-up window.

2. Enter Background Scale. If you already know the scale factor, you can directly introduce 
it. Be aware that the paper size of the floor plan needs to be set properly.

 3. After using this method, you can verify if by drawing the scale you get a 
measurement result within the expected range.

2

1

3
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System Builder | Design Mode 3/7

Multisite

Consider the following attention points:

1. In step 7. Add Distribution Board:

Don't forget to drag the DB on the Floor Plan. 

2.     Additionally, drag and drop the PDDEG-S inside the DB on the Floor Plan. Repeat the 
process for any spur Load Controllers that will be used.

1

2
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System Builder | Design Mode 3/4

Consider the following attention points:

1. In step 8. Set up wired fixtures (for wireless check specific chapter):

• Open Quick Fixture Setup

• Add each type of fixture that will be installed in the project, including its 
type, load, lifetime and icon.

2. In step 9. Place fixtures using the Shape recognition tool.

1. For each fixture, click Add shape and then on Select Shape. In the Floor 
Plan hold the left mouse button while dragging the mouse pointer over the 
shape you want to recognize as a specific fixture. Then, press enter.

2. For each shape, click Add fixture and choose among the fixture 
profiles created in step 8. Then, Search All shapes within perimeter wall to 
assign the recognized luminaires with the corresponding fixture profile.

• Alternatively, you can manually add the fixture profiles created in step 8 
directly on the Floor Plan but it's more time consuming.

3. Ensure all luminaires in the floorplan are assigned to a fixture profile as this is the 
base for the Notional Energy data

Multisite

1

2.1

2.2
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System Builder | Design Mode 5/7

Consider the following attention points:

1. In point 10. Group Fixtures:

• Use Draw Dali Cable to connect the DALI addressable universes, and Fixture Group 
to create the DALI broadcast groups or other circuits.

• Use Draw Fixture Group for grouping switchable luminaires.

2. Make sure created groups are linked with a Distribution Board by the cables

1

2

Multisite
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System Builder | Design Mode 6/7

Consider the following attention points:

1. In point 12. Draw Child Areas in a representative way that fits the real space of the area 

so that square meters are estimated correctly.*

2. Once the Area is drawn, assign the ID by clicking on the corresponding Area from 

template job file, and give the Area a representative name by clicking again on the Area 

from the template job file. Make sure to keep names and numbers consistent with the 

Interact Cloud configuration, and the Project Template PDF form. 

*Draw Areas for hybrid or wireless luminaires.

1

2

Multisite
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System Builder | Design Mode 7/7

Consider the following attention points:

1. In point 15. Select Hardware, open the Hardware Selector Window and drag and drop the corresponding Universes to your Load Controllers. Bear in mind 

that devices need to be dragged and drop under the DB on the Floor Plan to do this.

2. If your circuit requires a controller that is not in the template, select the circuit and from the list on the button choose the preferred controller and click it 

twice to add it to your project.

3. Once all the circuits and universes have been assigned, Apply it to Job and close the Hardware selector. 

 To close the System Designer tool, click again the Design icon

Multisite

1

2
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System Builder | Total Floor Area

Add the Total Floor Area in square meters 

This value will allow end users to get energy information per square meter in the dashboard. 

It can be given as:

1. An input from customer

2. AutoCAD measurements

3. Automatic estimation from the graphical commissioning if a proper scale was given.*

In any case, this information can be introduced in SB or alternatively, in the Cloud:

1. From System Builder, in Job Properties manually introduce your Total Floor Area input in 
the Site size field. Remember to save the project to align this information with the Cloud.

2. From the Cloud you can access to this value from Assets>Site List. Select the Site and from 
the Settings tab, scroll down until you see the Total Floor Area.

*To know the automatically estimated Total Floor Area from graphical commissioning, go to 
Building View, and get the top-level value which will be the sum of all the Areas drawn. 

*

Multisite

2

1
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System Builder | Finalize logical configuration and hierarchy 1/2

Create and rename Logical Channels graphically

1. From the Floor Plan window, click         to graphically group the fixtures that will be 
assigned to the same Logical Channel within an Area. To do the groups, hold the left mouse 
button while dragging the mouse pointer over the luminaires. Repeat this for all Logical 
Channels and all Child Areas.

2. In Areas view, make sure all Logical Channels and Child Areas use identical ID numbers and 
names, as configured in the Interact Cloud and the Project Template.

1

=

Multisite

2

Correct energy data reporting requires
ON/OFF and dimmable outputs to be in different Logical Channels.
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System Builder | Finalize logical configuration and hierarchy 2/2

Create Parent Areas graphically

1. From the Floor Plan window, select       Draw Base Area Region. Define each Parent Area 
by clicking on the vertices of the whole region within its range. Repeat this for all Parent 
Areas ensuring that all Child Areas are linked to a Parent Area.

2. In Areas view, make sure Parent Areas use the same name and ID as in the Interact 
Cloud and the Project Template form.

=

Multisite

1
2

3
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Offsite preparation

Rename Presets in Parent and Child areas

Each Area (including BLA) must be configured with 64 preset

Thanks to Multisite SB Template, all Areas are equipped with 64 Presets already.

• In Areas view, select Area and go to Presets tab. The most efficient approach is to 

select Parent Area and all related Child Areas together.

• Rename Presets to corresponding Scene names from Project Template Form

Multisite

System Builder | Rename Presets

At the end presets configuration in System Builder, Cloud and Project Template PDF form must be the same. 
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System Builder | Clean up job file 1/3

1- System configuration

- For each DALI Addressable Controller:

- Check if the correct DALI devices are within the expected DALI controller. If additional 
DDBCx20 have been created by System Designer to allocate the DALI devices, move 
the DALI devices to the corresponding Load Controller by drag and dropping them.

- Copy and paste configuration from sensors on the template to those added by you. 
Check next slide for more details on sensor configuration.

- For each Dry contacts used for alarm integration:

- Keep only the type of dry contact proposed in the template (DDMIDC8/DDLI8I8O) and 
choose between the standard (armed when dry contact closed) or reversed 
configuration (disarmed when dry contact closed). 

Multisite

1
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System Builder | Clean up job file 2/3

1- Antumbra configuration

- Copy and paste the configuration from one of the Antumbras on the template that better fits your 

configuration to the added Antumbra. Feel free to edit the Presets or Areas to control, as long as you 

use Join 0x83 for each button and the correct BLA so it keeps synchronized if Child Areas are being 

controlled.

 2- Touch Screen configuration

•Download the PDTS Multisite Master Template folder from the Partner Portal (Software and 

Tools>FLX>multisite)
- Open the last version of UI Creator via SB hob file* select the folder Multisite Master Template v1.

- The template includes 3 Areas with 4 Presets each. The Areas will automatically get the Area name.

- If required, please adjust number of Areas, Presets and names.

- Keep in mind join byte 0x83 and a proper BLA's are associated with Presets.

*Open UI creator by right-clicking on the PDTS and selecting UI Creator > Launch UI Creator. This way it 
will import Logical configuration changes (modified area numbers, names) into PDTS Multisite Template

Multisite

https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
https://partner-portal.cfapps.eu10.hana.ondemand.com/internal/index.html
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System Builder | Clean up job file 2/3

1- Sensor configuration

- For each sensor, both DALI and Dynet, copy and paste the configuration of one of the proposed sensors from the template.

- For each feature (Motion, Open Loop, or Closed Loop) choose the Area (Parent/Child) that the sensor will control and enable 
the desired features.

- Fine tune the settings of each feature but ensuring Join is 0x81 for Motion and 0x82 for Light Control, and BLA is filled with the 
corresponding Parent Area when sensor controls a single Child Area.

- Always use at least 1 minute Resend Inhibit Period to avoid over-flooding the DyNet network

- Set the maximum Update period time for minimizing the traffic on the network.

2- Energy meter configuration

- Add as many meters as required following the instructions at the end of this chapter.

- Configure the meters and power zones following the same instructions.

3- General review

- Check devices have unique names and delete those that are not used.

- Ensure the topology is correct with all the spur devices under the PDDEG-S.

- Make sure all controllers have 64 Presets. Otherwise, create them and synchronize from Logical to Device.

- Make sure all Areas (Parent+Child) have 64 Presets created.

Multisite
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System Builder | Join Bytes review

Offsite preparation

During commissioning (offsite preparation & onsite commissioning), ensure proper Join Bytes are set:

o 0x81 – Motion control

o 0x82 - Light regulation

o 0x83 -  Manual override (Antumbra / Revolution/ PDTS/ dry contacts)

o 0x84 – Scheduler message (no need to fill in)

o 0x85 – Alarm integrations

Join Bytes:

o Allow to understand network traffic (For problems root causing purposes)

o Are mandatory to enable a feature (0x83, Manual Override with timer)

o Will be used in future for other features

Multisite
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System Builder | Check Outputs settings

Except for addressable controllers (unassigned outputs during offsite 

commissioning), if luminaires have been assigned with the correct fixture 

profile and logical grouping by using System Designer and graphical 

commissioning, Load and BLA will be added to the outputs automatically:

1. Confirm that all available outputs have the Loads (watts) column 

filled with expected data, as well as the BLA and Power Category.

2. If Load is not correctly assigned, in the System View click the Project 

name on the tree, and select the Load Profiles tab.

3. Click on Sync Loads From Plan. Select any applicable option on the new 

dialog and click OK.

4. Confirm that all data is synchronized then in the outputs tab. If it is still 

not there, previous steps were not done properly. Alternatively, you can 

also manually fill these columns with the correct data.

3

2

Multisite
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System Builder | PDDEG-S Gateway 

Add the site gateway

1. In the System view, make sure all devices are under the PDDEG-S. 

2. On the Ports tab, add the PDDEG-S IPv4 network settings (Static/DHCP).

3. In the Task template, define the Base Link Areas to which Manual Override feature 
applies. Additionally, if Alarm integration is required configure the parameters on the 
Task Template. 

Multisite

1
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3
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System Builder | Additional configurations – unique naming

Rename Devices

When the same type of device exists multiple times in the system, make sure to 

change the name and make it unique. 

1. In the System view, right-click on the Device and select        Rename. 

Assign unique names, for example:

• 3xDDBC1200 → DDBC1200 #1, DDBC1200 #2, DDBC1200 #3

• 2xDUS360CR → DUS360CR (Storage1), DUS360CR (Storage2)

• 2xDDBC120 → DDBC120-DALI (Fresh), DDBC120-DALI (Groceries)

1

Multisite
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System Builder | Save job data to the cloud

Login to the cloud

The user account must be registered in Microsoft Azure Active Directory before you can 

login to the Retail Account.

1. On the Tools menu, click Interact Accounts

2. Click       Add, and select Multisite Account

3. Select Europe as a region, and click OK

4. Select your account to login to. If required, fill in your password

5. Account has been linked with Interact cloud

Save job file to the cloud

6. On the File menu, click Save As and select Save Job To Cloud

7. In the Work Order Selection menu, select the Region: Europe

8. Find and choose applicable work order, then click OK

9. Wait until the file is successfully saved to the cloud. Confirm this in the Application 

logs. Then, close the jobfile.

 

5

2
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8

3

Multisite
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Introduction

Functional test 

The purpose of a functional test is to test the integrity of the circuit and the correct operation of a lamp, a 

changover device and battery emergency power supply.

Duration test

The purpose of a duration test is to verify whether the battery has sufficient capacity to illuminate the 

emergency fixture for the rated duration.

Preparation:

▪ Clarify together with Customer requirements for Functional and Duration tests, especially define clear 

schedule and interval for all tests.

a

Multisite Offsite preparation
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Introduction

Multisite Offsite preparation

Emergency DALI Luminaires in System Builder

Emergency DALI luminaire with embedded battery might be discovered in 

System Builder as:

• Two DALI drivers with two short addresses (usually luminaires with 

integrated EM system)

• Single DALI driver with one short address (usually anti-panic lights 

and exit signages that work in maintained or non-maintained 

mode)  Anti-panic lighting

Exit signage

Luminaires with integrated emergency 
system 

Type 1

Type 2

Type 3
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Please note that:

▪ The rule of thumb is to assign emergency ballasts that are 

located next to each other in separate groups. 

▪ Each group must be tested separately. 

▪ At least one group must be always ready for the real emergency 

case

3

Multisite

EM Group 1

EM Group 2

EM Group 2

EM Group 1

EM Group 2

EM Group 1

EM Group 2

EM Group 1

EM Group 2

EM Group 1

EM Group 1

EM Group 1

Offsite preparation
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Multisite

Connected emergency lighting testing 

In system Designer mode:

1. Create additional emergency fixtures → 8.Set up Fixtures

• Configure Load = 0W for EM profile and luminaire with integrated EM 

system

• Configure nominal load for EM profiles with maintained operation mode 

(usually EXIT signs, anti-panic)

2. Place Emergency fixtures on the drawing

• In the designed location (anti-panic, Exit signs)

• Next to standard lighting fixture (for luminaires with integrated EM system)

1
2
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Multisite

3. Extend DALI line to cover all newly added EM fixtures  → 10 Group Fixtures

o Remember to connect end of DALI line with DB

4.   Link updated DALI universe with Dali controller in →15 Select Hardware → HW selector

5.   Apply to Job and quit Hardware selector 

6.   Close System Designer mode 

Connected emergency lighting testing 

4

5
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Multisite

Create Emergency Groups 

1. Go to System or Building Tab and click on the project name 

2. Go to Emergency Testing tab

3.     Click Add Group and create at least 2 emergency  groups

o The rule of thumb is to assign emergency ballasts that are 

located next to each other in separate groups. 

o Drivers in every second emergency group must be always 

available for the real emergency case. That means duration 

test should be performed only for maximum half of emergency 

groups at the time. Duration test for other groups should be 

started when all batteries are fully recharged in all groups

Create configuration groups 

4.   Click Manage test Config button and create at least 3 test configurations. 

5.   Specify Test Type for created Emergency Test Configurations. There 

should be at least 1 Functional and 2 Duration Test Types.

6.   Save job file to the Cloud

Connected emergency lighting testing 

1

2
3

4

5

Note: Assignment of Emergency Groups to Emergency test configurations is covered in 

onsite commissioning instruction
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Multisite metered energy | Introduction

 

 

Multisite

Configuration of energy metering is only required when smart 

meters are used to measure energy consumption. Otherwise, this 

step can be skipped.

Before you start creating the configurations for metered energy, 

make sure to: 

• Obtain and read the most recent documentation of the selected 

meter 

• Make sure that you understand the specifications of the 

selected meter and how to implement it. 

• Always follow the installation manual of the meter; contact the 

support line of the manufacturer of the meter in case of any 

questions
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Multisite metered energy | Preparation

In order to configure Metered Energy, following components are required:

System Builder

o Latest version, available on Dynalite.com

o Technician license →   

Firmware

o PDDEG-S version: 1.23 or higher

o PDEG/PDEB version: 3.58 or higher

 

 

Support.controls@signify.com
Support.controls@signify.com

Multisite

https://www.partner.portal.signify.com/
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Multisite metered energy | Preparation In order to configure Metered

 

 

Offsite preparation 

Prepare System Builder job file2

.

.

.

o Start with System Designer mode

o Finalize logical hierarchy

o Set Base Link Areas and channel loads

o Configure PDDEG-S Gateway

o Create preset placeholders

o Configure Manual Override, BMS and Alarm 

integrations

o Configure controllers, sensors, UI's

o Configure Job file time zone

o Save job file to the Cloud and close it.

Metered Energy configurations

o Open job file from the Cloud

o Additional PDDEG-S configurations

o Add and configure Modbus Meters

o Add and configure PDEG/PDEB/DDNG485

o Save job file to the Cloud

Modbus RS485 (RTU) Modbus IP (TCP)

o Open job file from the Cloud

o Add and configure Modbus Meters

o Configure PDDEG-S

o Save job file to the Cloud

A
B1

Step A – generic Multisite Offsite System Builder job file preparation

Step B – additional Metered Energy configurations

B1: Modbus RS 485 

B2: Modbus IP

Important: to configure Metered Energy, Step A must be accomplished prior to Step B

or

B2

Multisite
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Metered energy - Modbus RS485 | Add and configure Modbus meters

To add Modbus meters:

1. In the System view, add new DDNG485 device under PDDEG-S, and click on it.

2. Go to the Create Device tab.

3. Select Meters tab.

4. Choose Modbus Meter from the existing list or click Manage Custom Meters
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When selected Manage Custom Meters :

1. Click Import, to load Modbus from the external *.mmx file, for example → 

or,

2. Click Add Meter.

3. Create a Line.

4. Add Register and configure an Active Energy register, according to Modbus Meter technical documentation.

5. Click OK.
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Metered energy - Modbus RS485 | Add and configure Modbus meters
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Custom meter will appear on Meters list (DDNG485 --> Create Device tab)

1. Drag & Drop Custom Meter under DDNG485.

From now onwards, all the steps are relevant for Modbus meters added 

from SB list or created as Custom Meters

2.   Click on the Modbus Meter.

3   On the Device Properties tab, specify Meter Address and ensure 

meter is Enabled.
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Metered energy - Modbus RS485 | Add and configure Modbus meters

2

3

1
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Having selected Modbus meter in the System view:

1. Go to Modbus Configuration Editor tab.

2. Enable an Active Energy register.

3. In a Power Zone column, assign desired Power Zone to the Active 

Energy register.

Offsite preparation
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Metered energy - Modbus RS485 | Add and configure Modbus meters

Multisite
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Metered energy - Modbus RS485 | Additional DDNG485 configurations

In order to finalize DDNG485 configuration as a Modbus 

gateway:

1. In the System view select DDNG485.

2. Verify Comm Port1 and Com Port 2 configurations.

3. Cross check routing setting on the Routing tab.

4. On the Metrics tab, ensure Total Energy Consumption

metric Polling Interval is set to 15 minutes.

 

2

Multisite
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Metered energy - Modbus IP | Add and configure Modbus Meters

Step B2: Open Job file from the Cloud

To add Modbus meters:

1. In the System view, click on PDDEG-S.

2. Go to the Create Device tab.

3. Select Meters tab.

4. Click Manage Custome Meters 

 

 

1
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When selected Manage Custom Meters :

1. Click Import, to load Modbus from the external file

or,

2. Click Add Meter

3. Create a Line 

4. Add Register and configure an Active Energy register, according to Modbus Meter technical documentation.

5. Click OK

Offsite preparation
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Metered energy - Modbus IP | Add and configure Modbus Meters
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Custom meter will appear on Meters list (PDDEG-S--> Create Device tab)

1. Drag & Drop custom meter under PDDEG-S

2. Click on the Modbus Meter

3. On the Device Properties tab, specify Meter Address and ensure 

meter is Enabled. Fill in meter IP address and Port number.

Offsite preparation

79

Metered energy - Modbus IP | Add and configure Modbus Meters

2

3

1
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Having selected Modbus meter in the System view:

1. Go to Modbus Configuration Editor tab.

2. Enable an Active Energy register.

3. In a Power Zone column, assign desired Power Zone to the Active 

Energy register.

Offsite preparation
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Metered energy - Modbus IP | Add and configure Modbus Meters
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Multisite
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Metered energy - Modbus IP | PDDEG-S configuration

In order to finalize PDDEG-S configuration for Metered Energy:

1. On the Metrics tab, ensure that Total Energy Consumption

metric has a Polling Interval of 15 minutes

 

1

Multisite
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Metered energy - Modbus RS485 | Additional PDDEG-S configurations

Ensure System Builder job file is closed before running these steps:

1. Open Job file from the Cloud.

2. In the System View, click on PDDEG-S.

3. On the Ports tab, change the setting Use static IP address to 

True. Specify static IP address, Subnet mask and network 

Gateway IP address.

4. On the Ports tab, create an additional IPv4 Server Port,  

configured as shown on the picture.

5. Ensure all routs are configured in the Routing tab.

4

5

Multisite

3
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Metered energy - Modbus RS485 | Add and configure Modbus meters

To add Modbus meters:

1. In the System view, add PDEG/PDEB device under PDDEG-S, and click on it.

2. Go to the Create Device tab.

3. Select Meters tab.

4. Choose Modbus Meter from the existing list or click Manage Custom Meters
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When selected Manage Custom Meters :

1. Click Import, to load Modbus meter from the external *.mmx file, for example →

or,

2. Click Add Meter.

3. Create a Line.

4. Add Register and configure as an Active Energy register, according to Modbus Meter technical documentation.

5. Click OK.

Offsite preparation
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Metered energy - Modbus RS485 | Add and configure Modbus meters
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Custom meter will appear on Meters list (PDEG --> Create Device tab)

1. Drag & Drop Custom Meter under PDEG/PDEB.

From now onwards, all the steps are relevant for Modbus meters added 

from SB list or created as Custom Meters

2.   Click on the Modbus Meter.

3   On the Device Properties tab, specify Meter Address and ensure 

meter is Enabled.
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Metered energy - Modbus RS485 | Add and configure Modbus meters

2

3

1

Multisite



Signify Classified - Internal

Having selected Modbus meter in the System view:

1. Go to Modbus Configuration Editor tab.

2. Enable an Active Energy register.

3. In a Power Zone column, assign desired Power Zone to the Active 

Energy register.
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Metered energy - Modbus RS485 | Add and configure Modbus meters

Multisite



Signify Classified - Internal

Offsite preparation

88

Metered energy - Modbus RS485 | Add and configure PDEG/PDEB

In order to configure PDEG/PDEB as a Modbus gateway:

1. Configure PDEG/PDEB IP address, Gateway and Subnet. 

PDEG must belongs to the same network as PDDEG-S. 

2. On the Ports tab, create an additional IPv4 Client Port, 

indicating PDDEG-S IP address as a Hostname. Apply all 

shown settings.

3. On the Ports tab, configure Comm Port 1 as a Modbus 

Gateway type. Apply all indicated settings.

4. Cross check routing setting on the Routing tab.

5. On the Metrics tab, ensure Total Energy Consumption

metric Polling Interval is set to 15 minutes.

2

3

4

5
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Plan commissioning | Preparation

Request work order for Site Engineer

Before onsite activities, a work order for Site Engineer must be requested and proceeded 

by Global Software Operations team. The installer receives an email when the work order 

is assigned.

Install Philips Dynalite Enabler app

Before going onsite, install the Philips Dynalite Enabler app on the phone.

It is recommended to check if the Philips Dynalite Enabler app functions as expected to 

prepare for the onsite commissioning.

1. Open the app on your device

2. Select region: Global

3. Enter your username (email address), then tap Next

4. Enter your password. Tap Sign In

5. Select the work order. It is expected to observe work order summary page with a 

Start Commissioning button. Do not start commissioning before site visit.

Multisite

5



Signify Classified - Internal

Offsite preparation

92

Plan installation | Connectivity audit

Order hardware

System Designer tool can generate reports with complete overview of all designed in system 

components. Make sure all the hardware required for the project have been ordered. 

Perform a connectivity audit

IT department of customer should be informed about number of endpoints which must be accessible 

from the internal network in order to provide gateway connectivity to Interact Cloud.

More information is available on the Signify Partner Portal in the Security Statement document.

To ensure customer IT infrastructure is ready for the Multisite installation, it is advised to run on the 

customer site an Interact Connectivity Toolbox.

Ideally, this should happen prior to the commissioning date, with close cooperation between Signify 

and customer's IT department.

1. Visit Signify Partner Portal and download Interact Connectivity Toolbox software and 

Technical Note document

2. Follow all the steps described in the Technical Note

7

Multisite
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In this lesson, you have learnt:

• Which are the steps to be taken in the offsite 

commissioning.

• Base Link Areas need to be defined and linked to each 

channel before uploading the System Builder file to 

the cloud. Plus, all the areas have 64 presets, devices 

have unique names, and the gateway have 100 

schedules, 30 public holidays, and 30 special events.

• Manual Override integration features need the task 

and join additional configuration.

• How to configure Connected Emergency Light Testing 

feature

• Metered Energy configurations are only relevant for 

projects that are meant for monitoring of an Active 

Energy consumption through Modbus meters.

Lesson review
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Lesson review | Onsite installation, commissioning and validation

Multisite

Offsite preparation 

Prepare dashboard in the cloud

Prepare System Builder job file

Plan installation

Plan commissioning

Configure Smart Meter groups

Configure Modbus metering

Optional features configuration

Emergency Lighting 
configurations 

Customer input for Emergency 
Test schedule
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